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BASIC NAVIGATION 

Logging On 
The Workforce Central logon page provides access to all features in the Workforce TimekeeperTM

 

Application to which you have been given access. 
 

 

Workforce TimeKeeper Live Environment: 

http://workforceapp01.claytoncountyga.gov/wfc/navigator/logon 

Workforce TimeKeeper Development Environment: 
http://workforcedev01.claytoncountyga.gov/wfc/htmlnavigator/logon 

 

 
 

Login Credentials 

Your Kronos Username will be firstname.lastname (ex: john.smith) 

Your Kronos Password will be your Active Directory / Email Password 

 

NOTE: If you have problems logging in, please contact the Service Desk by phone at (770) 477-

3728, or via email at service.desk@claytoncountyga.gov. 
 

Logging in to Workforce Timekeeper 
 

1. Access the Navigator log on page. 
2. Enter your user name and password in their designated fields. 
3. Click the right-facing arrow or press the Enter key on the keyboard. Your navigator appears. 

 

Signing Out 
Signing Out of Workforce Timekeeper 

Signing out closes your session and signals the application to no longer provide access to any of its 

components, which can prevent others from accessing your 

information. To sign out of Workforce Timekeeper, click the Sign Out. 

 

http://workforceapp01.claytoncountyga.gov/wfc/navigator/logon
http://workforcedev01.claytoncountyga.gov/wfc/htmlnavigator/logon
mailto:service.desk@claytoncountyga.gov
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Recommended Practice 
Kronos recommends that you always end your work session by clicking the Sign Out link, located 

in the top-right corner. 

Clicking Close (X) without first logging off might leave your connection to the application open, 

allowing unauthorized people to view and edit information. 
 
 
 

Tip 
Save the Workforce Central URL as a “favorite” in your web browser for quick access. 

 

Accessing Support in the Application 
Workforce Central offers an Online Help resource. If you have access to Online Help, you can access 
the link in the Related Items pane. 

 
 

Using Online Help 

Online Help is your tool for on-the-job support. 
 

 Use the Contents tab to scan through the table of contents for the applications(s) in the 
suite that you are using. 

 
 Use the Search field to search for a specific topic of interest. 
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 If desired, click Maximize to gain more space on the screen.               Click Restore Down or 
Minimize to return the widget to its original size.  

 

Using the Inactivity Timeout 
The inactivity timeout screen appears if there is no user activity, such as saving or searching, for 

a set length of time. When the timeout warning appears, click Yes to continue. If you are finished 

with your session, click No.  

 

 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

NOTE: Your organization’s application administrator can configure the inactivity timeout by 

adjusting the Session Timeout parameter. 
 
 

Recommended Practice 
Be sure to click Yes if you want to remain logged in. If you do not click Yes after receiving the 

inactivity timeout message, you will be logged out of the application and will lose all unsaved 

edits. 

 

Using Your Navigator 
After you log on to the application, your Navigator appears. Navigators are customized views of 

the information that is important to completing daily work tasks in the application. All navigators 

include a home workspace that is displayed when you first log on. Workforce Central includes 

Navigator templates that are assigned based on user licenses. There are templates for employees, 

managers, managers who are also employees, and administrators. The templates can be used as is, 

or copied and modified as necessary. 
 

Parts of a Navigator 

Navigators have many different parts. Each part of a navigator either provides you with information 

or helps you to perform a task. 
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Screen Area 
 

Description 

Active Bar A horizontal area at the top of the navigator that displays the currently opened 

workspaces as tabs. Click a tab to bring a workspace into focus. Click the Refresh icon 

next to the title to reload the workspace with its default information. 

Name/Sign Out Identifies the user and provides a link to log out of navigator. Your photo may also 

appear here. 

Alerts Links, which appear as icons, enabling you to quickly view the type and number of tasks 

and issues that require your immediate attention. 

(Note: Alerts are optional) Search Click to open the Search widget, to locate employees and their information. 

Views and Widgets A workspace can have one or more pre-sized views. Views are holding areas for 

widgets, which are the task-oriented tools you use to review data and perform actions. 

In this example, there are two views, and each one currently holds a widget. When you 

need to work with a different widget, you can swap it into either view, replacing the 

current occupant. 

Related Items Pane Includes one or more additional widgets that are part of the workspace; the Related 

Items pane contains different widgets for each workspace. 

Search Name/Sign Out Alerts Active Bar 

Views and Widgets 
Related Items 

Pane 
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Managing the Active Workspace 
You can change your view of the information in the workspace or associated widgets. 

 

Primary and Secondary Widgets 

All workspaces have at least one primary view, and some also have one or more secondary 

views. Normally, to work in a widget you must move it into a primary view. Widgets 

occupying secondary views often provide useful information, but are not fully functional 

until moved into a primary view. 

 
 
 
 
 
  
 
 
 
 
 
 
 

 

 

 

Multiple Primary Views 

Some workspaces feature two equally-sized views in a side-by-side or top-and-bottom 

layout. In this case, both views act as primary views, and widgets in those views are fully 

functional. 

 

Repositioning Widgets 

Move a secondary widget into a primary position by clicking the title bar, dragging it over the 

primary widget, and releasing. 

 

Hovering for Details 

Hover the mouse to see a tool tip containing details, where applicable. 

 

Contextual Callouts 

Right-click a cell within a widget; in many cases, this opens a callout with detailed information 

and icons for any actions you are allowed to perform on that cell. 

Primary View Secondary View 
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Using the GoTo Control 
 

Depending on how your navigator is configured, you may be able to perform further actions on 

the entries in a widget. If your navigator has a GoTo control configured, you may be able to 

select one or more employees, click the GoTo control, and then access the employees’ 

timecards, the Schedule Planner, or another Workforce Central page where you can perform an 

action. 
 

Workspace Tabs 

Each active workspace gets its own tab. You can switch back and forth between workspaces by 

selecting the tab you want to view. You must always have at least one workspace open, but you 

can close any additional workspaces by hovering over its tab and clicking the close (X) button. 

 

 

Opening Workspaces and Widgets 

Opening different workspaces provides access to different sets of widgets. 

Opening Workspaces 

If you have been assigned more than one workspace, you can: 

 

 Access all available workspaces by clicking the plus (+) sign to open a new tab and select 

your desired workspace. 

 Click a workspace to make it active. 

 Click the X in the workspace tab to close the workspace (other than your default 

workspace). 
 

Additional Workspaces Click the + tab to 

open an additional workspace. To close that 

workspace later, hover over its tab and click 

the close (X) button. 

Opening Widgets 

Within any workspace, you can access widgets and activate them by bringing them into your 

active workspace. To open a widget: 
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 From the Related Items pane, select a widget OR click a widget and drag it into your 

active workspace. 

 To remove the widget, click the gear icon and click Close. 

 
 
 
 
Activating a Widget 

There are two ways to activate a 

widget in the Related Items pane.  

 
To add it to the current 
workspace, drag it out of the pane 
and release it over a widget in the 
workspace. 
 

To work with the widget in a 
temporary workspace, click the 
widget while it is still in the pane.  

To close that workspace later, 
hover over its tab and click the 
close (X) button. 

 
 
 
 
 
 
 

Widget View Options 

There are several ways to adjust the view or preferences of a widget to better suit your needs 

while you work though tasks.

 

 

Gear Icon 

Click to view options for moving the 
widget. Unavailable options will be 
grayed out. (For example, widgets in 
the primary view cannot use Close or 
Pop-out.) 

 
Preferences Option 

Select Preferences to edit settings for 
a widget, such as time period, and 
permanently save the changes. 
Preferences, if enabled, are saved 
only for your use in your own widget.

Resize Bar 

Click and drag the resize bar to 
reveal more of a particular secondary 
view. 

 
Pop-out Option 

Select Pop-out to promote a 
secondary widget to a primary 
position. 

 
 

Title Bar 

Click and drag a widget’s title bar to 
swap it with another widget or return 
it to the Related Items pane. 

Close Option 

Select Close to send a widget in a 
secondary view back to Related 
Items. 

 

Closing the Related  

Items Pane 

Click the right arrow to 
close the Related Items 
pane. When closed, click 
the left arrow to open it. 

  

Active Widgets 

Widgets already in an open 

workspace appear grayed 

out in widget list. 
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Maximize/Restore Icons 

Click to expand a widget in a primary view to its maximum size. (This will temporarily hide any 

other widgets.) Click again when maximized to restore to the original size. 

 

 

 
 
 
 
 
 
 

Using the Search Widget 
Employee search allows you to quickly locate information about employees, locations, and jobs in 

Workforce Central. In addition, Employee Search evaluates your search text and offers suggestions 

that are possible matches for the information you are searching. When you find the employee or 

other information you are seeking, you can frequently drill down to a deeper level of information. 

If a search widget has been configured for you, it will appear in the upper-right corner of the 

navigator.  

Enter part of an employee’s name and Search offers potential results that fit your criteria. For 

example, when you enter “jo”, your search returns: 

 

 A list called People. These are the employees who have those letters at the beginning of 
either their first or last name. 

 A list called Who have. This category contains a list of people who have an assigned 
manager with the search letters in either their first or last name. 

 A list called Were you looking for? This category contains possible items you may have 
been looking for that contain the letters entered in search. 

 
 

Performing Actions on the Items in the Results Pane 

Depending on how your navigator is configured, you may have several options for performing further 

actions on the entries in the Results pane. If your navigator has a GoTo control configured, you 

may be able to select one or more employees, click the GoTo control, and then access the 

employees’ timecards, the Schedule Planner, or another location where you can perform an action. 

 

Hints 

The Hints feature displays a drop-down list that contains categories that employees are assigned 

to. For example, to obtain a list of employees who have unexcused absences in the current pay 

period, from the drop-down list select Absence Unexcused > True. Then review the data in the 

Results pane. 
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Searching for an Employee Using Search 

1. Click the Search icon.  
2. Select an option to turn the Hints feature on or off.   
3. In the Search field, enter at least the first three letters of the employee’s first or last name. 

For example, jon. 
4. Click an entry to display more information in the Results pane. The information shown for the 

employee includes the employee name, badge number, contact information, job details, 
pay rules, and profiles assigned to that employee. 

5. While viewing an employee’s information in the Results pane, you can select GoTo Control 
to move to a different Workforce Central location. 
 

 

 

KnowledgePass 
For additional information on Navigating Workforce Central, access KnowledgePass and view the 

following job aids: 

 Manager Navigator Job Aid 
 Employee Navigator Job Aid 

 

Time Data Basics 

Viewing Exceptions and Comments 
 

Reviewing Exceptions in the Exceptions Widget 

The Exceptions widget is a specialized widget that displays exception data for hourly 
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employees, or employees who punch in and out to track their worked time. There are two views in 

the widget: 

 Summary 
 Details 

 

Exceptions Summary View 

Each column is an exception; a number in the column identifies an exception for the employee. The 

columns can be configured to meet the needs of your organization. This is a view-only mode. 

No tasks can be performed in this view. 

 

 

Details View 

Accessed from the Summary view, the Details view provides access to In and Out punches, schedule 

data, and more details about the exceptions. In this view, you can also resolve exceptions and enter 

comments. The detailed view is accessed by double clicking the line of an employee who has 

exceptions. This will take you to a timecard view containing only days with exceptions. 

 

Visual Indicators in the Details View 
 

The Details view provides several visual indicators to help you quickly interpret the data on the 

screen. 

 

Exception Type 
 

Details View Visual Indicator 

Unexcused Absence Date displayed in red text 

Early In/Out or Late In/Out In or Out time text displayed in red text 

Missed punch In or Out time cell filled with solid red 

Reviewed exception In or Out time text displays in green 
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When a comment is added to a punch in Details view of the Exceptions widget, a blue message 

balloon icon appears to the right of the punch. 

Reviewing Exceptions in Hourly and Project Timecards 
In Workforce Timekeeper, managers can access employee timecards in a central location, using 

the Timecard widget. Managers can review and address exceptions in both hourly and project 

timecards from the widget. 

Hourly Timecard View 

The hourly timecard is another tool for managing employee time data for hourly employees, or 

employees who punch in and out to track worked time. Similar to the Details view of the exceptions 

widget, there are visual indicators that identify time data discrepancies. There is also a visual 

indicator for a comment that has been attached to a punch. 

 

Exceptions can also be resolved in this tool, and comments can be added here as well. 

NOTE: Depending on how your organization decides to configure timecards, employees may see 

one or two sets of In, Out, and Transfer punches. Below is a view of an hourly timecard with the 

Timecard widget configured to display two punches per shift. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Project Timecard View 

The project timecard is a tool for managing employee time data for project or salaried employees: 

employees who track their time in durations, and do not punch in and out. The visual indicators in 

this view are similar to those in an hourly timecard. Exceptions can also be resolved in this tool, 

and comments can be added here as well. 

 

Visual Indicators in Hourly and Project Timecards 
 

The timecard views provide several visual indicators to help you quickly interpret the data on the 
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screen. 

 
 

Exception Type Hourly View Visual Indicator 
 

Project View Visual Indicator 

Unexcused Absence Red icon with white line near top in Date cell Same 

Excused Absence Blue icon with three white lines in date cell Same 

Early In/Out or Late In/Out Red icon with white line near top in the 
impacted punch cell 

NA 

Missed punch In or Out time cell filled with solid red NA 

Reviewed exception Green icon with three white lines in the 
impacted punch cell 

NA 

 

 

When a comment is added in a timecard, a blue comment bubble appears to the right of the punch. 

 
 

Tip 
To learn more about visual indicators in the different time data views, review the following topics 
in Online Help: 
 

 From Contents, access: Timekeeping > Timecard > Icons in the timecard and Colors in 
the timecard 

 From Contents, access: Timekeeping > Exceptions widget 
 
The following illustration shows a manager’s view of an hourly timecard with a time data exception 
and a comments indicator. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The following illustration shows a manager’s view of a project timecard with time data exceptions. 
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Accessing Employee Data Using Workforce Genies 

Using Workforce Genies 
Genies are highly customizable for users to ensure that they see only the data that is applicable 

to their business needs. Depending on your navigator configuration, you can select available 

Genies from either the Related Items pane or the Genies widget. 

The Genies Widget 

The Genies widget provides convenient access to Genies within your workspace. If configured, 

all the widgets that you have access to can be found in the Genies widget. 

Sorting, Grouping, and Refreshing Data in a Genie 

You can access the most up to date data within a Genie by clicking the refresh icon. You can also 

manage the look of the Genie by using the sort and filtering features within the Genie. 

 

Within Workforce Genies, you can sort columns of information by clicking the small arrow that 

appears when you hover over a column header to see your options for how to sort or group the 

data within the column. 
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Click Refresh to display the most current information. 

 

 
 

Filtering within Genies 

Use the filter function to narrow down the number of employees you are viewing within the Genie. 

 

After clicking the Filter icon, filter fields appear at the top of any columns that can be filtered. As 

you type in any of these filter fields, only rows containing the characters you type will remain in the 

workspace. 
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NOTE: You must click Refresh to ensure that you are viewing the most recent changes made to 

employee and application data. The Last Refreshed time (labeled “Loaded”) at the left of the context 

selector in the upper-right corner of the page identifies the most recent time you clicked Refresh. 

 

Sharing Data in a Workforce Genie 

Workforce Genies display critical information in an easy-to-read format. You can print this information 

or export the data to other applications, such as Microsoft Excel, where you can reformat the data 

for your business needs. 

 

 
 

NOTE: When the exported file is opened with a compatible application, each row appears on a separate 

line or row. 

 

Locating Employees Using the QuickFind Genie 

You can use the QuickFind Genie to search for a specific person or set of people. In QuickFind you can 

use the Name or ID field to change the list of employees that is displayed. You can also use the Time 

Period drop-down list to change the time frame of the records you want to view. 

1. Navigate to the QuickFind Genie. 

2. With the * in the Name or ID field, click the magnifying glass to display all employees that you 

have access to. 

3. In the Name or ID field, enter the last name or first 3 letters or a last name with the * after your 

entry. 

4. Click the magnifying glass or press Enter. 

5. If applicable, from the Time Period drop-down list, select the applicable timeframe. 

6. Click Filter. 

7. In the filter field of the applicable column, enter a value to further narrow down your returned 

results. 

8. Click within a column header to sort the column values in descending order. 

9. Select the employee or employees from the list and perform the applicable action. 
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Using Reports 

Running and Viewing Reports 
 

Running a Report 

1.   From the Related Items pane, click the Reports widget. 
2.   On the Select Reports tab, expand the All category and select the report you need to run. 
3.   Select your report criteria. 
4.   Click Run Report and then click Refresh Status. 

 
 
 

 
 
 

Viewing a Report 

1. When the status is Complete, click View Report. Note that the report opens in a separate 
window or tab, depending on your internet browser options. 

2. Access the tab or window and review the report. 
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SCHEDULING STAFF FOR SPECIFIC PERIODS 

Assigning Base Schedules 

The Schedule Planner Widget 
Workforce Timekeeper includes Schedule Planner, a powerful scheduling tool that helps you 

schedule worked and non-worked hours. The Schedule Planner presents a timeline view of 

employee schedules for a defined time period. 

 

Tool Bar 

Control the schedule display, 
save date, refresh data, 
or access the Quick Actions 
tool bar. 

 

Context Selectors 

Set options for the time 
period and group of 
employees. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Schedule Grid 

Review schedule data and perform tasks 
on existing data. The information in the 
grid will vary depending on the selected 
viewing option. 

 
 

Tool bar 

The toolbar is located along the top of the schedule grid and displays various viewing options and 

action buttons. 
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Quick Actions 

Quick Actions are one-click shortcuts that you can use to complete multi-step, common tasks. Using 

Quick Action shortcuts can reduce time spent on data entry as well as reduce data entry errors. 

When you select the Quick Actions icon from the too bar, the icon moves from left to right to 

reveal the Quick Action options. 

 
 

 

Viewing Options and Action Buttons 
 

Select the icons in the Tool Bar to adjust the view of the data or to perform actions on the data. 
 

 
 

 

 
Quick Action 

 
How to Use 

Insert Shift Transfer Click Insert Shift Transfer, select the transfer job or location, and select the shift in 
the schedule. 

Insert Shift Template Click Insert Shift Template, select the template, and select the applicable date cells. 

Comment Click Comment and select the applicable comment. Select the applicable shift or pay 
code to attach the comment. 

Pay Code Click Pay Code and select the applicable category and pay code. Select the applicable 
shifts to apply the pay code to. 

Copy/Paste Click Copy/paste and select the applicable shift to copy. Select the applicable date cell 
to paste the data. 

Delete Click Delete and click the applicable shifts, pay codes, or accruals. 

Lock/Unlock Click Lock/Unlock and then click an unlocked shift to lock it, or click a locked shift 
to unlock it. 
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Gantt View 

The Gantt view can be used while viewing data by employee, by job, or by schedule group. To access 

the Gantt view, click Gantt view in the Actions bar. 

 

 

 

 

 
Menu Item 

 
How to Use 

Employee data views 
 

 

 

Employee schedule data can be viewed by employee, by group, or by employment 
terms. Select the view from the View menu located in the Action bar to change the 
view of the data that is presented. 

 By Employee: Alphabetical list of employees and their day-by-day 
schedules. 

 By Group: List of employees and their schedule groups. Employees not 
in a group are listed first as “Ungrouped Employees.” 

 By Employment Terms: List of employees organized by employment 
terms. Employment terms are legal contracts between employer and 
employees regarding the number of hours and specific schedule to be 
worked. 

Column Selection Select available columns to add or remove from the grid. Your options may include 
Totals, Department, and Job. 

Visibility Filter You have the option to show or hide information that is available to you, like: Shift 
time, pay code name, accrual name, assigned shifts, pay codes, scheduled accrual 
amounts, and holidays. 

Select All Click this icon to select all the items within the schedule. 

Schedule views There are three different schedule views available within Scheduler Planner to help 
you to view and perform actions on schedule data. Available views are Gantt view, 
Tabular view, and minimized view. 

Sorting Click the icon to sort data within columns. 

Tools Click the icon to Manage employee schedule request periods. 

Refresh the schedule Click icon to revert to the last save. Click Yes to discard unsaved changes and click 
No to save changes (and then click Save). 

View Comments Click the icon to view comment information associated with schedule data 

Share Using the share feature, data can be printed or exported from the Scheduler Planner 
to an excel file. 
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Tabular View 
 

Tabular view can be used while viewing data by employee, by job, or by schedule group. To access 

Tabular view, click Tabular view in the Actions bar. There are some restrictions when using the 

tabular view: 

 It does not display segment information, only shift labels or start/end times 
 It shows shifts only in the day the shift starts, even if the shift extends to the next day 

 

 

 

Editing Schedules in Tabular View 

To edit schedules within tabular view, you can: 

 Double-click a shift to edit shift times or labels within a cell 

 Press tab or use the keyboard arrows to move between cells 
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Visual Cue 
Sample Cue in 

Gantt View 

Sample Cue in 

Tabular View 
Event Description 

Orange 

highlights 

and vertical 

line 

  Displays the 

current date 

and time 

 

 

Orange indicates the 

current day and in the 

Gantt view, the orange 

line indicates the 

progression of the day. 

Employee 

lines that are 

shaded gray 

 Inactive employees do not 

appear in Tabular view 

Indicates 
inactive 
employees 

Employees who are 
inactive in the 
organization. 

Double 

arrows 

  Transferred 

shift into the 

location is 

displayed in 

the Schedule 

Planner widget 

The employee is 

scheduled to transfer 

from another location 

into the location 

displayed in the 

Schedule Planner 

widget. 

 

OR 

 

An employee displayed 
in the Schedule 

Planner widget is 
scheduled to transfer 

all or part of a shift to a 
location that is not loaded 
in the Schedule Planner. 
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 The following table describes the Gantt and Tabular view indicators and their functions. 

Light gray, 

italic shift 

designation 

with double 

arrows 

  Transfer shift 

to a location 

that is not 

loaded in the 

Schedule 

Planner 

widget 

The employee would 

typically appear in the 

Schedule Planner 

widget based on the 

location selected; 

however, the 

employee is 

scheduled to work a 

shift in a location that 

is not selected for 

display in the 

Schedule Planner 

widget. 

Pay code 

abbreviation 

and hours 

  Pay code edit The employee is 

associated with the 

location in the Show 

field and time period, 

and has scheduled 

time off for that time 

period. 
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Tabular View Textual Indicators 
 

Textual Key 

d Shift segment details 

i Inheritance 

c Comments 

o Off 

l Locked 

u Unavailable 

x Transfer 

 

 
 
 

Lock icon   The shift has 

been locked 

and cannot be 

edited. 

A shift has been locked so 

that it will not be edited 

manually or affected by 

scheduling engines 

Comment 

icon 

  There is a 

comment 

associated 

with the shift 

A comment has been 

entered regarding the 

shift. 

White space 

in shift 

 Assigned breaks do not 

display in Tabular view 

One or more 

breaks is 

assigned during 

the shift 

An employee is 

working a shift that has 
assigned breaks at 

specific times. 

Red 

exclamation 

within a cell 

  
Schedule rule 

violation 

At least one violation 

has a severity of No 

Save. 

Orange 

exclamation 

within a cell 
 

 
Schedule rule 

violation 

At least one violation has 
a warning severity. 

Yellow 

exclamation 

within a cell 

 
 Schedule rule 

violation 

At least one violation 

has an informational 

severity 



32 | P a g e    K R O N O S - W o r k f o r c e  T i m e k e e p e r  8  
 

Minimized View 
 

When you minimize the Schedule Planner widget, it continues to show basic schedule information 

while another widget is open in the primary view. 

 

 

 
 

 

NOTE: Within the Schedule Planner grid, right-click on a cell to view actions. 
 

 

 

Day/Week Schedule Viewing Options 

Schedule views can be adjusted so that you are viewing schedule details for a specific day, or 

specific timeframe. 
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Viewing Information for a Day 

Click the column header of the applicable date to switch the schedule planner view so that you are 

viewing schedule information for a specific day. 

 

 
 

 

Viewing Information for a Period of Time 

Click the column header containing the range of dates for the schedule planner. 

 

 
 

NOTE: Organizations can customize columns in the Schedule Planner; therefore, you might see 

different Schedule Planner columns. 

Contact your Workforce Timekeeper Application Administrator to include or remove columns so 

you see only the information you need to perform your scheduling tasks. 

The Department and Job columns are available only to organizations that implement organizational 

maps and jobs. 

If your Application Administrator has set up the employee self-service feature, you will be able to 

track all requests from the Schedule Planner. This is true regardless of the state of the request 

(submitted, approved, or denied). All requests will also remain in the database for searching and/or 

tracking. 

Your organization can choose to configure the system to utilize Rolling Request Periods which 

automates the opening and closing of schedule and request periods so you do not have to manually 
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do this task. 

Employee Tool Tip 

Schedule Planner data appears before the Day columns (Sun-Sat) and are included in summary 

format in the Employee tool tip. This is helpful if you want to include additional columns in the 

Schedule Editor (such as badge number, e-mail address, and phone number(s)) but also want to 

maximize the number of Day columns visible without scrolling. 

 

Schedule Patterns 
What is a Schedule Pattern? 

A schedule pattern is: 

 A group of shifts that repeat over a specified time period 
 Includes a start and end date 
 Controls the shift assignments for employees 
 Facilitates exception-based tracking of time and enforcement of restrictions and rounding 

rules 
 

Pattern Templates 

Patterns can be entered manually or by using a pattern template. A pattern template is a reusable 

tool that contains one or more shifts that rotate over a period of time. 

Pattern templates include: 

 Pattern name and description 

 Recurring interval that defines the number of days or weeks over which the pattern repeats 

 Shifts associated with the pattern 

You assign a pattern template to one or more employees for a specific time period to quickly create 

standard elements in employee schedules. Then, you fill in each employee’s unique schedule 

information. 

Use the Select Pattern dialog box to quickly assign a schedule pattern to employees. Then fill in 

each employee’s unique information. 
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Assigning Schedule Patterns 
When a new employee is added to Workforce Timekeeper, you can also assign a schedule pattern 

to the employee. If it does not exist, a pattern might need to be added to an employee’s record. 

Using the Pattern Editor 

If your organization uses schedule patterns, you might occasionally need to add a new pattern or 

change an existing pattern. Use the Pattern Editor to add, modify, and delete assigned schedule 

patterns. The following illustration shows a sample Pattern Editor for an employee with an assigned 

pattern. Notice that the employee is scheduled to work from 9:00 A.M. to 5:00 P.M. Monday 

through Friday. 

 

 

Modifying Schedule Patterns 

You might determine that an existing pattern is not exactly what you need. The following illustration 

shows an example in the Pattern Editor with a shift change in Friday’s cell. Notice the color change 

in Friday’s cell that indicates that the shift designation is different from the original schedule pattern 

assignment. 
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NOTE: Use the Pattern Editor or Shift Editor to modify the schedule pattern. 
 
 

Assigning a Schedule Pattern 

1. From the Schedule Planner, right-click the applicable employee’s name. 
2. Click Schedule Pattern. 
3. Verify the Anchor date. 
4. In the Start Date field, enter the start date of the pattern. 
5. In the End Date field, enter the date the pattern should end, or select Forever if there is no 

end date. 
6. In the Define Pattern for field, enter the number of weeks or days you are defining the 

pattern for. 
7. Select the corresponding option from either Week(s) or Date(s). 
8. From the Pattern Template drop-down list, select the applicable pattern. 
9. Verify that the template populates the calendar grid, and click Apply. 
10. Click OK. 
11. Verify that the pattern has populated the Scheduler Planner grid. 
12. Click Save. 

 

Scheduling Staff to Meet Workload Requirements 

Modifying Shift Assignments 
If you have employees that work similar hours during each schedule period, you can assign 

schedule patterns to those employees so their schedules repeat every schedule period. However, 
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employees might occasionally need to work alternative shifts. 

Shift Assignment Tasks 

 Enter an “X” beside the task you need to perform in your organization. 

 

 

 

 

 
NOTE: If you delete a shift that is part of a pattern, the shift can later be restored, however, it can 

only be restored to the last saved pattern for the employees. 

Adding a Shift by Typing in a Cell 

1. In the Schedule Planner, using the Context Selector, ensure that the group of employees 
you want, and the time period in which you want to add a shift, are displayed. 

2. Click a date cell for an employee. 
3. In the cell, enter the start and end times of the shift separated by a hyphen, and then press 

the Tab key. 
 For example, enter 9a-530p and then press the Tab key. 

 
4. Click Save. 

 

NOTE: that you can enter time using either 12-hour or 24-hour time formats. For example, you can 

enter 8:00 A.M. to 5:00 P.M. as 0800-1700 or as 8a-5p. 

Adding a Shift Assignment Using Copy and Paste 

1. In the Scheduler Planner, click Quick Actions to reveal the Quick Actions menu. 

 

 
 

2. Click Copy/Paste. 

3. Click the cell you want to copy. 

4. Click the cell(s) you would like to paste the information to. 

 

Task  
 

I need to perform this task… 

Add a shift  

Edit a shift  

Delete a shift  

Restore a shift  
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5. Click the Copy/Paste function again to turn the feature off. 

6. Click Save. 

 

Shift Editor 

You can add and modify simple shifts directly in the Schedule Planner by typing directly in the cell 

or by copying and pasting an existing shift. However, for more complex shifts, use the Shift Editor. 

The Shift Editor is a scheduling tool that lets you create and modify a shift and its associated shift 

segments for one or more employees. 

The following illustration shows a sample Edit Shift dialog box containing a shift with the three 

segments. 

 

Shift Editor Tasks 

Enter an “X” beside the task you need to perform in your organization. 

Task   I need to perform this task… 

Create a shift with multiple segments  

Assign a shift label to an entire shift  
Add one or more comments to the shift  
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Adding a Shift Using the Shift Editor 

1. Locate the employee’s row and right-click the cell in the row and under the date where you 

want to add a shift. 

2. Select Add Shift. 

3. In the Shift Editor, confirm that the Employee and Start Date are correct. You can either 

click Insert Template and seek a preformatted shift template, or manually create a shift. 

4. To manually enter a shift, select a shift type from the Type drop-down list, and enter a Start 

Time and End Time. 

5. If the shift contains multiple segments, click + to add a row and repeat steps 4 and 5 as 

necessary. 

6. Confirm that the date in the End Date field is correct. If the shift segment crosses a day 

divide, change the shift’s end date to the following day. 

7. In the Repeat this shift for field, enter the number of consecutive days you want to schedule 

this shift. 

 

 
8. Click Apply and then click Save. 

 

Scheduling Non-Worked Hours Using the Pay Code Editor 
Non-worked Hours Overview 

Although employees are scheduled to specific work hours each week, events occur that cause 

employees to miss time. Employees might communicate this missed time to their managers in 

advance, allowing managers to make appropriate changes to the scheduled workforce. 

 

Pay Code Editor 

Use the Pay Code Editor to schedule non-worked hours for one or more days for employees. 
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Accessing the Pay Code Editor 

You can access the Pay Code Editor from any of the following: 

 Schedule Planner 

 Detail Genie 
 Roll-up Genie 

 
 

 
 

KnowledgePass 

If you are a Workforce Leave manager with access to KnowledgePass, refer to the Editing Leave 

in a Timecard or Schedule job aid for additional information. 

Scheduling Non-Worked Hours 

1. In the Schedule Planner, locate the employee’s row and right-click the applicable date cell 
where you want to schedule non-worked hours. 

2. Select Add Pay Code. 
3. Confirm that the correct Effective Date appears. 
4. From the Pay Code drop-down list, select the applicable pay code. 
5. In the Amount field, enter the number of non-worked hours. If applicable, you can select Full 

Scheduled Day or Half Scheduled Day. 
6. If the non-worked hours must replace an existing shift, select the Override Shift check box. 

Then select Whole Shift to override the entire shift, or Partial Shift to override only those 
hours that overlap with the non-worked hours. 

7. In the Start Time field, enter start time for the pay code. 
8. In the Repeat for field, enter the number of consecutive days to schedule this non-worked 
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time. 
 

 
 
9. Click Apply and then click Save. 
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MONITORING TIMECARDS TO FACILITATE PAYROLL 

PROCESSING 

Reviewing Notifications of Time Data 

Using the Exceptions Alert and Widget 
The Exceptions widget can help you to manage employee time data exceptions quickly and 

efficiently. You can access the widget using the following methods: 

 Clicking the Exceptions alert; this activates the Exceptions widget and moves the data to 

an open workspace. 

 Clicking and dragging the Exceptions widget to the open workspace. 

 Clicking the widget to open it in a temporary workspace. 
 

The Exceptions Alert 

The Exceptions alert quickly draws your attention to time data issues in timecards for hourly employees. 

It is: 

 An optional configuration. 

 Applicable only to hourly employees who have triggered a time data exception that 

requires your attention. 

 Available when you log in; it displays an alerts indicator in the top center or your navigator.  

 

Time data exceptions alerts can notify you about issues such as missed punches, late or early in 

punches, and late or early out punches that require your immediate attention. 

The alert icon includes a number in the upper-right corner that tells you how many employees 

have time data issues. 

Select an employee from the list to access the Summary and Details views of the exceptions widget. 

When you click an employee’s name, you are brought to the Details view of the Exceptions widget. 
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Refresh 

Click the Refresh icon to  
get immediate updates to  
your alerts. 

 

 

 

 
 
 

 
 

 

 
 

 

 

 

 

Alert Icons 

Each type of alert has its  
own icon. A number in the  
icon’s corner indicates that 
there are items you should  
review. Click an icon to  
view details. 

 

Alert Details 

Click an item in the 
details of an alert to open 
the relevant widget. You 
can then take whatever 
actions are needed in the 
open widget. 

 

View All 

Click to open the Alerts and 
Notifications widget. This 
provides more room for 
reviewing alerts, and may 
also include uncategorized 
alerts and notifications that 
are not actionable. 
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The Exceptions Widget 
The Exceptions widget is a specialized widget that displays exception data for hourly employees 

or employees who punch in and out to track their worked time. Managers can perform most of the 

tasks they need to accomplish on their employees’ time data in the Exceptions widget. Some of the 

key functions that can be performed in the detail view include: 

 Add and remove punches 

 Add comments 

 Mark exceptions as reviewed 

 Change an employee’s time to their normally scheduled time 
 

NOTE: The exceptions widget displays time data exceptions for hourly employees only. There are 
two views in the widget: 
 

 Summary 
 Details 

 

Exceptions Summary View 

The Summary View: 

 Provides an at-a-glance view of employee exceptions 

 Displays one or more exception types by column 

 Allows your organization to configure the columns based on your business requirements 

 Displays exceptions by employee 

 

Double clicking on an employee listed in the Exceptions Summary view will open the Detail view, 

which allows you to view details for one employee at a time.  
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Details View 

The Details view is populated only when an employee has an exception. If there are no exceptions, 

the Details view for the employee is blank. From this view, you can: 

 See the dates and exception details 

 Access an employee’s hourly timecard view 

 Toggle to display or hide an employee’s schedule 

 Resolve exceptions manually or by using one of the available action buttons 
 

Accessed from Summary view, the Details view provides access to in and out punches, schedule data, 

and more details about exceptions. In this view, you can also resolve exceptions and enter 

comments. 

Visual Indicators in the Details View 
 

The Details view provides several visual indicators to help you quickly interpret the data on the 

screen. 

 
Exception Type 

 
Details View Visual Indicator 

Unexcused absence Date displayed in red text 

Early in/out or late in/out In or out time displayed in red text 

Missed punch In or out time cell filled with solid red 

Reviewed exception In or out time displayed in green 

 

 

Resolving Exceptions in the Exceptions Widget 
Action Buttons in the Exceptions Widget 

Depending on the type of exception and its status, action buttons appear along the bottom of the 

page. Only the relevant actions are available. The following table lists and describes the action 

buttons you will see in the Exceptions widget. 

 
 
Action Button 

 

Description 

Save Save your changes to the database. 

Cancel Cancels changes that you made prior to saving. 

Justify Allows you to review exceptions that were either justified by employees or that need to 
be justified by you. You can approve the employee change, approve application-
delivered resolution, or justify the exception. Once justified, the exception color changes 
to green. 

Mark as Reviewed Indicates that you have reviewed the exception, and that no further action is required. 
The color of the exception changes to green and the Mark as Reviewed button changes 
to Unmark as Reviewed. 



47 | P a g e    K R O N O S - W o r k f o r c e  T i m e k e e p e r  8  
 

Change to Scheduled Changes a missed in or out punch to the scheduled time. This feature only works for 
employees who have assigned schedules. 

Comment Adds a comment, and optionally a note, to an employee’s punch data. 

Add Punch Opens the Add Punch dialog box and inserts a punch time. 

Remove Removes punch data. 

 
NOTE: When making employee timecard edits to Justify Exceptions, your system administrator may 

have configured the system to allow for Standard and Cascading pay codes in addition to Duration pay codes. 
 
 

The following image highlights the action buttons within the Exceptions widget. 

 
 

Tool Tip for Resolving Exceptions 

The Details view of the Exceptions widget provides tips for resolving each particular exception type. 

If you hover the cursor over a time data exception, the application displays a recommendation. 

 

 
 

Resolving Punch Issues Using Change to Scheduled 

To fix a missed punch exception, you can use the Change to Scheduled option. This button is 

available only with missed punch exceptions for employees who have schedules assigned to them. 

If you know that the employee started work or left on time and simply forgot to punch, click the cell 

containing the missed punch to activate the Change to Scheduled button. The button is available 

only when the missing punch is either the first punch of the day or last punch of the day. For missing 

punches in the middle of the day, only the Add Punch option is available. 
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Resolving a Missed Punch with Change to Scheduled 

1. Access the Time Exceptions widget. 
2. From the Time Period drop-down list, select the applicable pay period. 
3. Select the applicable group. 
4. Select the applicable employee and then click View Details. 
5. Click the cell with the missing punch and click Change to Scheduled. 
6. Click Save. 
 

 

NOTE: The Change to Scheduled button is only available when the missing punches are either the 
first or last punch of the shift. For missing punches in the middle of a shift, use the Add Punch 
option. 
 

Using Add Punch 

The Add Punch feature allows you to enter punch information in the time data using the Add Punch 

dialog box. In this dialog box, you can select the punch type and enter a punch time. 

 

 
 

Adding a Punch in the Exceptions Widget 

1. In the Details view in the Exceptions widget, click the cell containing the exception and then 

click Add Punch. 

2. In the Add Punch dialog box, confirm the date. From the Insert drop-down list, select the 

applicable punch option. 

3. Enter the appropriate punch time and click Add. 

4. Click Save. Confirm that the exception no longer appears in the time detail view. 
 

 

NOTE: You can also double-click a punch cell and enter a punch. 

Unsaved Data Indicators 

When you change any time or data information in the Exceptions widget, the Save and Cancel 

buttons turn orange, indicating that there is unsaved data. 

 Click Save to write the edits to the database. 
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 Click Cancel to refresh the data, which reverts the data to its previous condition.  

When you save or cancel, both indicator buttons become inactive. 

 
 

Phantom data 

Punches and pay code amounts that appear in purple text represent phantom data. Workforce 

Timekeeper automatically adds these entries to a timecard based on an employee’s schedule 

assignment. 

 

 

 

 

 

Entering Comments 

Comments are predefined, organization-specific descriptions that you attach to punches to 

provide additional information about that transaction. 

Comments let you document specific details of worked and non-worked hours to help you with 

future analysis. If you have access, you can also add free-text notes to comments for clarification. 
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Adding a Comment 

1. After making an edit within the Time Data Exceptions widget for an employee, access the 
details view. 

2. Select the applicable punch. 
3. Click Comment. 
4. Select the applicable comment. 
5. If applicable, click the + to add a clarifying note. 
6. Click OK. 
7. Click Save. 
8. Validate that the comment is attached to the punch by hovering over the applicable punch. 
9. To view any added notes, select the applicable punch and click 

Comment. 
10. Scroll down and click the + next to the selected comment. The note text 

appears. 
11. Click Cancel to exit the screen. 

 

Marking an Exception as Reviewed 

Even if alerts are not configured, managers can view summary and details of any employee time 

data exception by accessing the Exceptions widget. Managers can perform most of the key tasks 

they need to accomplish on their employees’ time data in the Exceptions widget, including marking 

and unmarking an exception as reviewed. 

You would mark an exception as reviewed to indicate that you have seen it, and do not want to 

see it repeatedly in general queries and searches. Only punch exceptions can be marked as 

reviewed. 

Note that after an exception is marked as reviewed, it disappears from the Summary view of the 

Exceptions widget, and it appears with a green check mark in the Reconcile Timecard Genie if all 

exceptions of that type have been marked as reviewed. 

Marking Exceptions as Reviewed 

1. The Details view, select the cell containing the 

exception. 

2. Click Mark as Reviewed. 

The exception turns from red to green. 
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3. Click Save. 

 

Unmarking Exceptions as Reviewed 

1. In the Details view, select the cell containing the exception. 
2. Click Unmark as Reviewed. 
 
The exception turns from green to red. 
 

 

3. Click Save 
 

Tip 
Add a comment to a resolved exception if you want to note additional information about the 

resolved exception. 

Use HyperFind functionality to search for resolved exceptions and general exceptions. 

Removing a Punch 

Many organizations discourage the modification of punches that originate from data collection 

sources, such as a Kronos 4500 device, because these punches reflect actual times an employee 

worked. However, there are exceptions to this rule. For example, an employee might punch twice 

when starting or ending a shift. If this occurs, you can delete the double punch. 
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Removing a Punch 

1. Access the Time Data Exceptions widget and select the applicable pay 
period. 

2. Select the applicable employee and click View Details. 
3. Click the applicable punch and click Comment. 
4. Select the comment that represents the reason for the punch removal. 
5. Click OK. 
6. Click Save. 
7. Click the applicable punch cell again and then click Remove. 
8. Click Save. 
9. To verify that this issue was resolved, navigate back to the 

Summary view of the Time Data Exceptions widget. 
10. With the applicable employee selected, access GoTo > Audits. 
11. Verify that the deleted punch and comment attached to the deleted 

punch appear within the grid. 

 

 

 

 

 

 

 

 

 

 

 

 

Recommended Practice 

Before you remove a punch, attach and save a comment to it. You cannot add a comment to a 

punch after the punch is deleted. Adding a comment provides documentation about why you 

deleted the punch. 

 

Using Pay Codes to Track Non-Worked Time 
Although employees are scheduled to work specific hours each week, inevitably events occur that 
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cause employees to miss time. In addition, there may be circumstances when employee’s need to 

be paid above and beyond their worked hours. For example, a bonus payout needs to be added to an 

employee’s pay. 

Pay codes facilitate payroll processing by grouping specific types of worked and non-worked 

hours and monetary amounts to accurately track time data. 

 
 

Note: The application also supports the use of combined pay codes. Combined pay codes are totals 

of several pay codes and appear in the Totals tab of the timecard, or in a report. 

For example, you might create a combined pay code named All Worked that is a sum of all worked 

pay codes. 

Adding Non-worked Time 

Most organizations have a variety of pay codes, such as holiday, vacation, and bereavement leave, 

which let employees track non-worked hours to an appropriate category. 

1. In the Details view, hover your cursor over the Pay Code cell and click the green plus sign. 

2. In the Pay Code Edit dialog box, select the appropriate pay code from the Pay Code drop-

down list. 

3. In the Amount field, enter the number of hours using an acceptable format, or select 

one of the scheduling amount options. 

4. If necessary, modify the value in the Start Time field. 

5. Click OK. 

6. In the Details view, click Save.



54 | P a g e    K R O N O S - W o r k f o r c e  T i m e k e e p e r  8  
 

Note: Workforce Timekeeper converts entries to your organization’s default time format. 

Pay codes that appear in the Pay Code drop-down list in a timecard are specific to the task of 

entering and editing employee time. Different pay codes might appear for selection when you 

generate a report or view data in a Workforce Genie. 

Accessing Hourly and Project Timecards 

Workforce Central provides several methods for accessing hourly and project employee 
timecard data, including: 

 Via the View Timecard link in the Exceptions widget Details view 

 Using a Workforce Genie 

 Using a GoTo Navigation link 
 

Accessing Timecards via the Exceptions Widget Details View 

If an employee appears with an exception in the Exceptions widget Summary view, you can 

either double click the employee’s line, or select the employee’s line and select Timecards from the 

GoTo menu. 

 

 

 

 

 

 

 

 

 

 

 

The employee’s timecard appears. You can perform an action on the timecard, or close the 

timecards workspace to return to the Details view of the Exceptions widget. 

You can access an employee’s timecard in most widgets using these same steps. 
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Analyzing and Resolving Exceptions in Hourly Timecards 
Resolving Time Data discrepancies in the Hourly Timecard 

The hourly timecard view allows you to perform additional tasks for hourly employees, beyond 

resolving time data exceptions. In this topic, we will review: 

 Saving time data changes in the hourly timecard view 

 Transferring employees 

 

Note: When making employee timecard edits, your system administrator may have configured the 

system to restrict your choices to only those pay codes, work rules, job, codes, and labor accounts 

derived from the employee’s assigned profile set. This restriction might be set, for example, to 

prevent inadvertently assigning a pay code or other item that is inappropriate to the employee in 

his or her timecard. 

Saving Changes to Information in the Timecard View 

Unsaved Data Indicators 

Similar to the Exceptions widget, the hourly timecard view provides visual indicators to inform you 

when you have unsaved data. The Save icon turns orange when changes have been made to 

timecard information. If changes have been made that impact timecard totals, the Calculate Totals 

icon will also turn orange. 

 

 

 

 

 

 

 

Saving Changes 

After you complete you edits, you must click Save to write those edits to the database. When you 

do, the visual indicators will disappear. 

Saving Changes within a Timecard 

1. Complete your edits within the timecard. 
2. If you decide you no longer want the edits to be made, click Refresh. The data will return to the 

state before edits were made. 
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3. To save your edits, click Save. 
4. If your data is not updated, click Refresh. 
 

Refreshing Workforce Timekeeper Data 

Clicking Refresh cancels unsaved edits and displays data as of the last save. 

 To discard any changes, after clicking Refresh, click Yes. 

 If you click Refresh, but want to save the changes, click No and save the data. 
 

Calculating Totals Before Saving Changes 

In some cases, you may want to calculate the totals that were impacted by your edits before 

saving the data. To do this, perform these steps. 

1. Complete the edits within the timecard. 
2. Click Calculate Totals. 
3. If you decide you do not want to save the edits after review the impacts, click Refresh. 
4. If you decide to move forward with the edits, click Save and, if necessary, click Refresh. 

Transferring Employee 

During the normal workday, all worked and non-worked hours are calculated using the employee’s 

default work rule and charged to the employee’s assigned labor account and job. 

Employees are each assigned to a primary labor account, a default work rule, and possibly a primary 

job. Employees are not limited to working where they have been assigned. 

Using the Transfer Field 

Use the Transfer field in the timecard to transfer employee’s time to a new labor account, work 

rule, or job. Click Search to display the Select Transfer dialog box. 
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Transferring an Employee 

1. Access a Genie and click Refresh. 
2. Select an employee and access GoTo > Timecards. 
3. Select a day you want to transfer hours to. 
4. Click the Transfer cell in the row for the applicable date. 
5. If the applicable job does not appear in the Transfer list, click Search. 
6. In the Job Transfer tab of the Transfer dialog box, click + until you reach the applicable job. 
7. Click Apply. 
8. Click Save. 

 

Using the Transfer Field 

Use the Transfer field in the timecard to transfer employee’s time to a new labor account, work 

rule, or job. Click Search to display the Select Transfer dialog box 

Note: If employees regularly work in multiple location, they can be set up to automatically distribute 

their hours to multiple labor accounts, pay codes, and/or organizational jobs. 

 In addition to searching for transfers, a short list of transfers can be displayed. By default, 

the list displays a user’s most recent transfers, known as the Most Recent Used (MRU) list. 

However, some organizations can choose to limit the labor accounts and work rules 

that employees can transfer to. The MRU list can be replaced with an Easy Transfer list. To 

learn more about Easy Transfers, access content on KnowledgePass.
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REVIEWING AND SUBMITTING TIMECARDS 

Approving Employee Timecards 

Approving Employee Timecards 

You need to validate that all employee timecards are ready for payroll processing and that your 

employees have applied their approvals. After the timecards are validated, you can apply your 

approval and check the results. If the approval is successful, Payroll personnel can then start 

preparing time data for payroll processing. 

Approval Effects on Editing Capabilities for Managers 

After a manager applies an approval to a specified time period for an employee, the ability of the 

manager to perform further edits depends on his or her access rights. 

Check with your Workforce Timekeeper Application Administrator to determine whether you 

can edit employee timecards that you or another manager has approved. 

Visual Indicators of Timecard Approval Status 

Workforce Timekeeper provides visual cues within employee timecards that represent approval 

statuses. The timecard is shaded various colors depending on where the timecard is within the 

approval process. 

The following table identifies the various timecard shading colors and what they signify. 

 

Timecard Color 
 

Status of Timecard 

Orange Timecard has been approved by the employee only 

Yellow Timecard has been approved by the manager only 

Green Timecard has been approved by both employee and manager 

Grey Timecard has been signed off by either the employee, manager, or both 

 

Approving Employee Timecards Using the Approval Wizard 

1. Access the Timecard Approval wizard. 
2. Confirm or modify the values in the Time Period and HyperFind field. If you make any 

changes, click Save. 
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3. Click Next. 
4. Review the Exceptions widget for any exceptions that have not been addressed. Correct 

the exceptions as necessary. Click Next. 
5. Select one or more employees whose timecards you want to approve. Hint: If you are not 

viewing the applicable Genie, select the applicable Genie from the drop-down list. 
6. Select Approval > Approve Timecard. 

 

 

  

 

 

 

 

 
 

7. Click Yes on the pop-up message. Then click Next. 
8. Review the results of your time approvals. To start a new timecard approval, 

click Clear. 
 

 
 
 
 
  
 
 
 

9. Click OK on the pop-up message. 
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Removing your Approval 
After you apply an approval to one or more employee timecards, those employees can no longer 

edit their timecards for that time period. However, there might be circumstances when an 

employee needs to make further edits to a timecard after a manager has applied an approval. 

Removing your approval from a timecard allows other managers—and possibly the employee—to 

edit time data for the dates from which you removed your approval. 

If your organization chooses to implement this feature, you will be able to remove and re-apply 

approval as needed. 
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APPENDIX 
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USING THE WORKFORCE TIMEKEEPER INTERFACE 

Basic Navigation 

Searching for Employees Using the QuickFind Genie 

The QuickFind Genie is a convenient tool you can use to search for a person or a set of people 

in the application. 

 

 

 

 

 

 

 

 

 

You can use the following methods to search for employees: 

 Search by employee’s last name 

 Search by name or ID 

 Search by partial name or ID 

You can also change the list of people that appear by selecting a different period from the Time 

period drop- down list. 

Searching by Employee’s Last Name 

In the Name or ID field, enter the employee’s last name and click Find. 

 For example, enter Babson and click Find. 

 QuickFind returns the list of all employees whose names begin with the letters Babson. 
 

Searching by Name or ID 

In the Name or ID field, enter the employee’s ID number and click Find. 
 For example, enter 601 and click Find. 
 QuickFind returns the person with ID 601. 

 

Searching by Partial Name 

If the employee you are looking for has a long name, or if you are unsure how to spell it, you can 

use the asterisk (*) wild card character, which allows you to search using just the first letter or first 

few letters of the employee’s name. 
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1. In the Name or ID field, enter the first few letters of the employee’s name, followed by an 

asterisk (*), and click Find. 

 For example, type ca* and click Find. 

 QuickFind returns the list of all employees whose names begin with Ca. 

 Note: that you can use the wild card character in the middle of a name. For example, if 

you don’t know whether an employee’s name is MacDonald or McDonald, you can enter 

M*Donald, and QuickFind will return all employees whose names begin with M and end 

with Donald. 

 

Searching by partial number or ID 

You can also search by partial ID by entering the first number or first few numbers, followed 

by the * character in the Name or ID field. QuickFind returns all employees whose IDs begin with 

those numbers.
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SCHEDULING STAFF FOR SPECIFIC PERIODS 

Adding and Removing Employees from Schedule Groups 
Adding Employees to a Schedule Group 

1. In the Schedule Planner, click View > By Schedule Group. 
2. Using the Context Selector, select the applicable group and time period. 
3. Select the employees you want to add. 
4. With the ctrl button still pressed, right-click one of the selected names and select Add to 

Group. 
 

 

 

 

   

  

 

 

 

 

 

5. In the Add to Group dialog box, select a group from the Schedule Group drop-down list. 
6. Enter or select a Start Date and an End Date for the schedule group assignment. 
7. If the schedule group that you selected allows schedule inheritance, select the check box 

to remove the employees from their other schedule inheritance groups for the date range. 
8. Click Apply. 
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Removing Employees from a Schedule Group 

1. In the Schedule Planner, click View > By Schedule Group. 
2. Using the Context Selector, select the applicable group and time period. 
3. Select the employees you want to remove. 
4. Select Group > Remove from Group. 

 
 

5. In the Remove from Group dialog box, select the schedule group from the Schedule Group 
drop- down list. 

6. Enter or select a Start Date and End Date for the schedule group assignment and then click 
Apply. 

 



66 | P a g e    K R O N O S - W o r k f o r c e  T i m e k e e p e r  8  
 

Scheduling Staff to Meet Workload Requirements 
Managing Group Schedules 
Using Schedule Inheritance in the By Group Tab 
When an inheritance schedule group is assigned to employees and a group schedule is assigned to 

the schedule group, all members of the group inherit, or acquire, the assigned schedule. Employees 

can be in multiple schedule groups but they should be associated with only one schedule inheritance 

group. 

 
 

Modifying a Shift within a Schedule Group 

1. Access the Schedule Planner. 
2. If not viewing by group already, from the View drop-down list, select By Schedule Group. 
3. Click the Context Selector to select the applicable timeframe and employee group. 
4. Locate the applicable Schedule Group within the grid, and right-click the applicable date cell. 
5. Click Edit. 
6. Verify that the Start Date is correct. 
7. In the Start Time field, enter the start time of the shift. 
8. In the End Time field, enter the end time for the shift. 
9. In the End Date field, enter the date that the shift should end. 
10. Click Apply. 
11. Click Save. 
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Ad hoc Shifts 

If you manually edit a shift for an employee that is part of a schedule group, the shift becomes an ad 

hoc shift. Therefore, its link to the inherited schedule is lost. The shift’s association with the group 

scheduled shift cannot be restored, even if the modified shift is deleted. 

The following illustration shows the gold-colored visual indicator that appears in the cell with an ad hoc 

shift. 

 
 

Making Group Edits Using Genies 

From any Workforce Timekeeper Genie, you can make the following group edits: 

 Add or replace a shift 

 Insert transfer 

 Append a pay code 

 Add or delete a pattern 

 Lock/unlock days 

 Add/remove from group 

 Pay From Schedule 
 

Performing a Group Edit from a Genie 

1. From the Related Items pane, select the Schedule Group Multi-line Genie. 
2. Using the Context Selector, select the applicable group and timeframe. 
3. Sort the Genie by Schedule Group Name. 
4. Select all employees in the applicable schedule group. 
5. Select Schedule > Insert Transfer. 

 

 
 

6. In the Effective Date field, enter the effective date of the transfer. 
7. In the Transfer Start Time field, enter the applicable time. 
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8. In the Transfer field, click Search. 
9. In the Labor Account area, select the applicable option. 
10. Select the applicable option. 
11. Click OK twice. 
12. From the Related Items pane, select Group Edit Results. Review the results of the Schedule 

Transfer Inserted group edit. 
 
 
 
 
 
 
 
 
 
 

13. Access the Schedule Planner and confirm that you are viewing By Group. 
14. From the Time Period drop-down list, select the timeframe you originally select for the transfer. 
15. Locate the selected group and review your results. 
16. If necessary, click Refresh. 

 

 
 
 

Caution 
Inheritance functionality does not apply when making group schedule edits in a Genie. 

 
Note: The Insert Transfer functionality within a Genie allows you to move shifts for employees 

selected in the Genie. The application inserts the transfer into all the shift segments that contain the 

transfer start time and that are scheduled on the Effective Date for the transfer. 

An example of when this might be useful is when you need to move all employees to a different work 

area due to a temporary building closure. 

For shifts that have multiple segments, the Insert Transfer function inserts the transfer into every shift 

segment. If this function is not the results you want, then do not use the Insert Transfer function on 

these types of shifts. 
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Paying Employees from Schedules 
Using the Pay from Schedule Feature 

Workforce Timekeeper can be configured to pre-populate employee timecards automatically with the 

scheduled hours based on their schedules. Paying employees from their schedules lets you pre-

populate their timecards with scheduling data, letting you pay employees the exact amount of their 

scheduled worked hours. 

This functionality is useful for employees who do not need to punch in every day but track their hours 

on an exception basis. 

When to use Pay from Schedule 
 

 

Employee Type 
 

Pay From Schedule use 

Project or salaried Pre-populate timecards with scheduled hours on a regular basis so that 
timecard edits are only needed for exceptions to scheduled times. 

Hourly Pre-populate timecards with scheduled hours on a temporary basis when 
needed, for example, if an employee temporarily won’t have access to record 
worked time, or payroll needs to be processed before the end of the pay period 
because of a holiday. 

 

 

 

 

 

 

 

 

 

 

Paying from Schedule 

1. Select a Genie from the Genie widget. 
2. Using the Context Selector, select the applicable group and time period. 
3. Select an employee. 
4. From the menu options, select Schedule > Add Pay From Schedule. 
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5. In the Effective Start Date field, select the applicable date. 
6. In the Effective End Date field, select the applicable date. 
7. Click Apply. 
8. Access the Group Edit Results page and review the information in the Pay From Schedule 

Added transaction to ensure that the edit was successfully processed. 
9. Navigate back to the Genie widget. 
10. Select the applicable employee, access GoTo Control > Employee Timecard. 
11. Review the dates and validate that the edits were made. 
12. If necessary, click Refresh. 

 

 

 

 

 

 

Scheduling Labor and Work Rule transfers 
Scheduling Transfers and Off Shifts 
About Shift Transfers 
During a normal workday, Workforce Timekeeper uses the default work rule to calculate employee 

worked and non-worked hours, and then charges the hours to the assigned primary labor accounts and 

jobs. 

On occasion, you might need employees to perform other jobs or work in other cost centers for which 

they are qualified. In this situation, you can schedule a transfer to have employee hours calculated 

differently. 

You can schedule a transfer for: 

 An entire shift 
 A portion of a shift 
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Transfer Types 
 

Transfer Type 
 

Description 

Labor account Transfers shift hours to an alternate labor account in your accounting structure. You can 

transfer hours to one or more labor levels in a labor account. 

Job Transfers hours to an alternate job in your organization. Each job has a specific path in 
your organizational map; therefore, Workforce Timekeeper specifies the entire job path 
when you perform a job transfer, ensuring that you track the transferred hours to a valid 
job. 

Work rule Transfers hours to an alternate work rule so that those hours are calculated differently. 
Work rules identify details such as how punches round, what types of overtime an 
employee can earn, and which pay codes track what types of hours. 

 

Sample Shift Transfer Tool Tip 

The following illustration shows one type of transfer indicator (x), and the tool tip describing the 

transfer. 

 

 

 

 

 

 

 

 

Tip 

You can hold your mouse over a shift transfer entry in the Schedule Editor to display a tool tip with 

the complete transfer information. 

 

Transfer Indicators in the Schedule Planner 
 

The Schedule Editor displays visual cues next to the shift times or shift label to identify transfers. 
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Transfer Dialog Box Sample 

The Transfer dialog box is a tool that lets you schedule hours to other labor accounts, jobs, or work 

rules. 

 
 

Scheduling a Transfer 

1. In the Schedule Planner, locate the employee’s row and right-click the cell in the row under 
that date where you want to schedule a transfer. 

2. Select Add Shift. 
3. Enter Start Time and End Time for the transfer. 
4. Depending on the type of transfer, click within the Job Transfer, Labor Level Transfer, or Work 

Rule Transfer cells. 
5. From the drop-down list, select the applicable transfer location. If the item you want does 

not appear within the list, click Search. 
6. Select the applicable tab, and then use the tree (Job Transfer), drop-down lists (Labor 

Account), or lists (Work Rule) to make your selections. 
7. Click Apply. 
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8. Confirm that the date in the End Date field is correct. If the shift segment crosses a day divide, 
change the shift’s end date to the following day. 

9. In the Repeat this shift for field, enter the number of consecutive days to repeat the transfer. 
 

 
 

10. Click Apply and then click Save. 
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MONITORING TIMECARDS TO FACILITATE 

PAYROLL PROCESSING 

Reviewing Notifications of Time Data 
Using the Reconcile Timecard Genie to View Exceptions 

The Reconcile Timecard Genie displays at-a-glance, summarized information about scheduled and 

worked time differences for employees. 

 

 Black check marks represent unresolved exceptions 
 

 Exceptions marked as reviewed in the timecard are displayed with a green checkmark 
 

 After all exceptions of a specific type are marked as reviewed, they are removed from 
Reconcile timecard 
 

 

 

Using the Work & Absence Summary Calendar 
The Work & Absence Summary Calendar uses colors, icons, and text to display information from 

multiple Workforce Central applications, such as Workforce Timekeeper and Workforce Scheduler, 

to help identify absence and time trends for an employee over a selected time period. 
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Note: Calendar colors might be different from assigned colors in the graphical views of the 

Schedule Planner. These colors might also be configured differently in different Workforce products 

used by your organization, such as Workforce Timekeeper and Workforce Absence Manager. 

Resolving Exceptions in the Exceptions Widget 
Justifying an Employee’s Missing Time 

Missing time is any instance of time that employees have missed when they were scheduled to 

work. In Europe, many organizations need to ensure that employees are working a target number 

of hours per day, week, month, or year. To help European organizations comply with labor laws 

that govern target hours, missing time exceptions can be automatically resolved with paid or unpaid 

duration pay codes. 

 

To understand how this process works, imagine that your organization auto-resolves missing time 

exceptions. Your employee left work two hours early last Tuesday. Here are the steps that must be 

followed by both you and your employee to accurately account for missed time. 

 

Justifying Missed Time 

1. The employee reviews the timecard. In the timecard, the employee must justify any 
exception that has a Missing Time pay code. The employee selects the Out punch, selects 
Punch > Justify Exception. The employee selects a justification from the list and submits the 
timecard for manager approval. 

2. As the manager, when you review the Summary page in the Exceptions widget, this 
employee appears with an Early Out Missing Time exception. 

3. You can review the employee’s reason for the missing time, and either confirm the 



76 | P a g e    K R O N O S - W o r k f o r c e  T i m e k e e p e r  8  
 

justification, change to another justification, or use a combination of justifications. 
4. You then mark the exception as reviewed and approve the 

time data. 

Canceling a Meal Deduction 
An automatic meal or break deduction is a length of time defined in an employee’s work rule 

that is automatically deducted from shift hours when that employee works a specific length of time. 

 

If, for any reason, the automatic deduction needs to be canceled, you can perform the task by 

editing the punch data. 

This task is performed in the Edit Punch dialog box, which is accessible from the employee’s 

timecard. You select the applicable type of deduction from the Cancel deduction drop-down list. 

 

 

 

Example: An employee is scheduled to work from 8 A.M. to 5 P.M. with a lunch break from 12 

P.M. to 1 P.M. The hour is automatically deducted from the employee’s shift total; 8 hours instead 

of 9 hours. If the automatic deduction needs to be canceled, you can perform that task by editing 

the punch data. 

 

Paying an Employee for Working through a Meal 

1. Access Reconcile Timecard. 
2. Using the Context Selector, select the applicable time period and group of employees. 
3. Access an employee’s timecard. 
4. Right-click the applicable punch and click Edit. 
5. From the Cancel Deduction drop-down list, select the applicable meal deduction. 
6. Click OK. 
7. Click Save. 
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Recommended Practice 

Add a comment to the edited punch to document the reason for edit. 
 

Analyzing and Resolving Differences in Project Timecards 
Entering Worked Time as Durations 
Employees using project timecards track their worked hours by entering amounts of time spent on 

different projects or worked in different areas. The Hours Worked pay code identifies worked 

hours in a project timecard. This pay code is referred to as a duration. 

A duration represents a block of worked time for which the employee’s pay rule determines how to 

allocate time. A duration is simply a number of worked hours that require processing to determine 

how to pay the employee. 

You use pay codes to enter durations into a timecard. Although you enter durations the same way 

you enter pay codes, Workforce Timekeeper calculates durations differently than pay code 

amounts. The application applies the appropriate pay rules to durations; it does not apply pay rules 

to pay code amounts. You can enter durations up to 999:59 hours; however, you cannot enter 

negative durations. 

Resolving Issues with Worked Hours in Project Timecards 
Employees sometimes need to adjust their worked hour amounts. For example, an employee might 

not complete time entries because that employee did not report to work as scheduled, or left early 

because of a family emergency. You might need to complete an employee’s time entries and apply 

an approval to that employee’s timecard before submitting the timecard for payroll processing. 

 

Visual Cues for Missing Durations 
Project timecards track hours for employees who enter spans of time instead of in-punches and out 

punch. If your organization uses the basic scheduling feature in Workforce Timekeeper, then 

phantom data might appear in the timecard. In that case, employees only need to apply exceptions 

to their hours. 

The following illustration shows a sample timecard for a project-based employee with an Hours 

Worked entry missing on Monday, the second week of the pay period, as indicated by the red line 

within the date cell and by the total number of hours being reduced by eight compared to the 

previous week. This entry is called an unexcused absence exception. 
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Adding Non-Worked Time to Project Timecards 
Most organizations have a variety of pay codes, such as holiday, vacation, and bereavement leave, 

that let employees track non-worked hours in the appropriate category. 

Adding Non-Worked Time to a Project Timecard 

1. Select an employee and access GoTo Control > Employee Timecard. 
2. Use the Context Selector to select the applicable timeframe. 
3. To add a new row, click the Pay Code cell in an empty row to display the available pay 

code options. 
4. From the Pay Code drop-down list, select the applicable non-worked time pay code, for 

example, Vacation. 
5. Click the Amount cell and enter the applicable amount of hours. 
6. Right-click the pay code amount to add a comment, like Approved. 
7. Click Save. 

 


